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Lab5 - Signal Analysis

Introduction

is lab introduces some useful tools for signal
analysis. ese include: a waveform editor, numerical
analysis soware and a spreadsheet. ese tools allow
you to perform sophisticatedmeasurements.

In this lab you will use these tools to sample three
waveforms, compute their probability distributions
and calculate theRMSvoltages of thewaveforms from
their probability distributions.

Each of these tools is very flexible and their func-
tionality overlaps. However, each program is best
suited for different tasks and it’s useful to be able to
transfer data between them. Each program typically
reads and writes a limited set of file formats. To
exchange data between programs you must under-
stand the differences between file formats and how to
convert between them. You will use a program called
a hex editor to examine the file contents and this will
help you understand the differences between the file
formats.

To become familiar with these tools you will
measure the statistics of the three waveforms that
can be generated by the lab’s function generator:
square, triangle and sinewaves. Youwill capture these
waveforms and use Matlab or FreeMat to compute
histograms that estimate the probability density
functions of the waveforms. You will also measure
the signal powers using an RMS voltmeter. You will
import the histogram data into a spreadsheet and use
the spreadsheet to plot the probability distributions,
compute the RMS powers from the distributions and
compare them to the powers measured using the
voltmeter.

WaveformCapture

epurpose of waveform capture is to sample a signal
at the desired sampling rate and resolution and save
the samples to a file. For low-frequency signals a
computer’s sound input hardware can be used. In
this lab we will use the Audacity sound editor for

waveform capture.
However, in most cases a digital oscilloscope

would be a better option because the input levels are
calibrated and it has well-defined input impedance
and frequency response.

Numerical Analysis

Numerical analysis soware can be used to analyze
digitized signals more flexibly than is possible with
normal test equipment. For example, the soware can
compute simple statistics (mean value, power, etc),
estimate probability distributions, compute power
spectra (power versus frequency), modify the signal
byfiltering it, compare signals (suchas the transmitted
and received versions), search for and count events of
interest (such as errors) andmany other tasks.

Numerical analysis soware has extensive signal-
processing and statistics libraries and support for
high-level data structures such as complex vectors
and matrices. is makes it possible to perform
complex analyses with relatively little programming.

For this lab you can useMatlab or a free and largely
compatible alternative called FreeMat.

Spreadsheets

You should already be familiar with spreadsheets.
ey are useful for manipulating and presenting
limited amounts of data and formatting numerical
data for reports.

For this lab you can use Excel or OpenOffice Calc.

HexEditor

Hex editors allow you to examine and modify the
individual bytes stored in files. is provides a very
flexible but low-level interface to files. You can
use HxD or wxHexEditor, two free hex editors, to
compare different file formats.

File Formats
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Binary (RawData) Files

e simplest file format consists of the sample values
written to a file. e user must keep track of the
number of bytes per sample, the endian-ness of the
data if there is more than one byte per sample, the
sampling rate, duration, etc.

e term “binary” in this case simply means that
the data is not in text format.

Text Files

Text files contain characters and can be read by peo-
ple. For example, you can print a text file containing
numbers and read the values directly.

A common text file format for exchanging data
between spreadsheets uses comma-separated values
(CSV).Each lineof thefile corresponds toone rowand
the values for each column are separated by columns.

Strings can also be included inCSVfiles by quoting
them although in this lab we will restrict ourselves to
CSV files with numerical values.

FileswithMetadata

ere are alsomanyfile formats that includemetadata
(data about the data) such as the number of samples,
sampling rate, bits per sample, etc. Examples include
the .wav file format typically used for uncompressed
audio files. Although these types of files are very com-
monwewill not have time to examine them in this lab.

Procedure

Signal Capture

Connect the output of the function generator to
both the ’scope and the voltmeter so you can view
the waveform and measure it’s voltage on the DMM

simultaneously. Note that the Fluke multimeters in
the lab are unusual in that they are RMS-responding.
Most DMMs are average-responding and only mea-
sure the average value of a signal. ese DMMs
voltage reading only corresponds to the RMS voltage
when the signal is a sine wave.

Adjust the signal generator output for a square-
wave output at a 1 kHz frequency with a 200mV
amplitude (400mV peak-to-peak).

e sound input on the PC can be configured for
either microphone or line-level inputs. To avoid
over-driving the sound card, configure it for line-level
inputs by using the Sound applet in the Control Panel
(on the right column when you press the Start button
the lower le of the screen). Select the Recording tab
in the Sound applet, select the Microphone input and
click on Properties. Under the Custom tab de-select
the Microphone Boost checkbox. Click on OK to
close the Properties window and OK to close the
Soundwindow.
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Plug in the patch cable used in previous labs to the
microphone input on the front of the PC. Connect
the yellow wire to ground and either of the other two
wires to the signal generator output.

e additional load presented by the sound card
input will reduce the signal level. Re-adjust the signal
generator’s output level and DC offset so that the DC
voltage is zero and the (RMS) AC voltage is 200mV.
For a square wave this corresponds to a 400mV
peak-to-peak voltage.

Run Audacity. On the devices toolbar select “1
(Mono) Input” and then press the red record button.
is will create a new mono audio track and begin
recording waveform samples. Adjust the input
volume control (beside the microphone icon) so that
the waveform takes up about half of the total range.
Leave the input volume control fixed at this level for
subsequent steps.

Press Stop, delete the waveform and press Record
again to create a new track. Record about 10 seconds
of the waveform. At a sample rate of 44.1 kHz youwill
have about 400,000 samples.

Select File->Export. Choose an appropriate folder
and file name (e.g. lab5square on your H: drive)
and “Other uncompressed files” as the file type. Click
on Options and select “RAW (headerless)” for the
Header and “Signed 16 bit PCM” for the Encoding.
LeaveMetadata fields blank.

Change the signal generator to a triangle-wave
output and check with the ’scope that the amplitude
(peak-to-peak) voltage is still 400 mV. Check that the
average (DC) voltage is zero. Record themeter’s RMS
voltage reading.

Delete the previous track, capture the triangle wave
signal and save the waveform to a new file.

Switch to a sine wave signal and again check that
the peak-to-peak voltage is 400mV,measure the RMS
meter reading and capture about 10 s of waveform.

You should now have three RMS voltage readings
and three waveform files all captured with the same

input volume control level. Each file should be about
800kB (two bytes for each of 400,000 samples).

e rest of the lab can be done without test equip-
ment but you should try to do asmuch of it as possible
during the lab session in case you need to repeat some
of yourmeasurements.

WaveformAnalysis

Run Matlab or FreeMat. Open the waveform data file
using the command:
fi = fopen('h:lab5square')

which should return a small positive value, typically
3. Read all the samples in the file:
s = fread(fi,inf,'int16') ;

print the first two sample values:
s(1:2)

and record the values. Plot the first 100 samples of the
waveform to make sure you captured and have read
the waveform correctly:
plot(s(1:100)) ;
Save this plot to an image file so that you can

include it your report later:
print('h:lab5square.png')
Compute the scaling factor that will convert the

sample values to volts by dividing the known RMS
voltage by the RMS value of the sample values:
c=0.2/std(s)
Compute the histogram of the voltage waveform

using the hist() function:
[n,v]=hist(c*s,100);

which will return a 100-element vector n with the
number of samples values in each histogram ’bin’ and
a vector v with the voltages at the midpoints of each
bin.

We can then export the histogram to a CSV file by
opening a file for writing:
fo=fopen('h:lab5square.csv','w')

and writing the values to the file as strings separated
by commas, two per line:
fprintf(fo,'%d, %f\n',[n,v])

and closing the file:
fclose(fo)
Repeat for the triangle and sine waves using the

value of the scaling factor computed for the square
wave (the variable c above).
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File Formats

Run the HxD or wxHexEditor hex editor (you may
need to install it from the course web site). Open
and examine the first 16 bytes of the waveform file.
Compare the hex values to the sample values printed
byMatlab and answer the following questions:

• how many bytes are required to store each sample
value?

• are the bytes in little-endian or big-endian order?

Use the hex editor to examine the first line of the
CSV file. Answer the following questions:

• how many bytes, including control characters, are
required to store each pair of values?

• are the values in little-endian or big-endian format?
Explain. (Hint: this is a trick question.)

• what are some advantages and disadvantages of text
and binary files?

RMSCalculation andReport

To compute the RMS (root mean square) voltage we
must compute themean (average) of the square of the
voltage and then take the square root of the mean. In
cases where different powers have different probabil-
ities we must scale each power by the probability of
that power and then compute the sum. For example,
if 20% of the values had a power of 0.3W and 80% had
a power of 0.2W then the average power would be
0.2× 0.3 + 0.8× 0.2 = 0.06 + 0.16 = 0.22.

We can use a spreadsheet to do this calculation on
the histogram values stored in the CSV file.

Run Excel or OpenOffice Calc. Open the CSV file
(File->Open) which will result in a spreadsheet with
two columns, the first with the bin counts and the
secondwith the bin voltages.

Enter a formula at the bottom of the first column to
compute the total number of samples. Add additional
formulas to divide by this value to normalize the bin
counts to probabilities. en compute the square
of each bin voltage and scale it by the probability of
that voltage. Compute the sum of the scaled squared
voltages. is is the mean square voltage. Finally,
compute the square root of the sum. is is the RMS
voltage of the waveform.

Repeat using the histograms for the triangle and
sine waves (Data->Get External Data or Import-

>Sheet from File). Compare your results to the values
read from the DMM.

Create a line graph (chart) with curves showing
the normalized values of the sine and triangle wave
histograms.

LabReport

Create a zip file containing:

1. the three histogram files (.csv format)
2. the Excel (or OpenOffice Calc) file (.xls format)
3. your report (.pdf format)

and submit it to the course dropbox for this lab.
Your report should include:

• student and lab identification as described in the
first lab,

• plots of the first 100 samples of the three sampled
waveforms,

• answers to the questions given in the section on file
formats above,

• the chart showing the three histograms as created
by your spreadsheet,

• a table comparing the measured and computed
RMS voltages for each of the three waveforms

Please don’t show your data to other students or
copy other’s data. Plagiarism will result in a mark of
zero for both students.
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